MELSEC MEDOC plus
IEC Programming and
Documentation System

Beginner’s Manual
About this Manual

The texts and illustrations in this manual are provided exclusively as a guide to the IEC programming and documentation system MELSEC MEDOC plus. Separate manuals are available for MITSUBISHI ELECTRIC’s various series of MELSEC programmable logic controllers.

The MELSEC MEDOC plus software is supplied under a legal License Agreement and may only be used and copied subject to the terms of this License Agreement.

All rights reserved. Without the prior explicit consent in writing from MITSUBISHI ELECTRIC no part of this manual may be reproduced, stored in a retrieval system of any kind, or transmitted, in any form, or by any means, electronic, mechanical, photocopying, recording or otherwise, or translated into another language.

MITSUBISHI ELECTRIC reserves the right to make changes to the technical specifications and information in this handbook at any time and without prior notice.

The IEC 1131.1 standard cited in this manual is available from the publishers Beuth Verlag in Berlin (Germany).

4th edition
Copyright January 1998

MITSUBISHI ELECTRIC EUROPE B.V.
Factory Automation
Gothaer Strasse 8
D - 40880 Ratingen
Germany
Phone: (+2102) 486-0
Fax: (+2102) 486-717

Printed in Germany
Article number: 43596-D (Beginner’s Manual)
Chapter 1: Introduction

This manual...

The Reference Manual...

If you’re not yet familiar with MS Windows...

If you’re not yet familiar with the IEC 1131.3 standard...

If you already have IEC 1131.3 experience and want to get to work right away...

If you get stuck...

Typographic Conventions and other Tips

Chapter 2: Getting to Know MELSEC MEDOC plus

What’s New in MELSEC MEDOC plus?

Introduction to the IEC 1131.3 Standard

Chapter 3: Basic Terms Used in IEC 1131.3 Standard Programming

Projects

Program Organisation Units (POUs)

Programs, Function Blocks and Functions

Parameters and Instancing

Tasks

Variables

Programming Languages

Networks

The Text Editors

The Graphical Editors

Chapter 4: Installation

Hardware Requirements

Copyright

Installing MELSEC MEDOC plus
Chapter 5: The User Interface ........................................ 5 – 1
The Elements of the User Interface ............................... 5 – 1
  The Menu Bar ..................................................... 5 – 2
  The Toolbar ...................................................... 5 – 2
  Windows ............................................................ 5 – 2
  The Status Bar ................................................... 5 – 2
  The Project Navigator ........................................... 5 – 2
Declaration Tables ................................................... 5 – 3
The Editors ......................................................... 5 – 5

Chapter 6: Getting Started ........................................... 6 – 1
S1 Creating New Projects ........................................... 6 – 2
S2 Creating Tasks .................................................... 6 – 4
S3 Declaring Global Variables ..................................... 6 – 5
S4 Creating Program Organisation Units ....................... 6 – 7
S5 Programming POU Headers .................................... 6 – 8
S6 Programming POU Bodies ...................................... 6 – 9
Programming Examples ............................................. 6 – 10
  Inputs and outputs in ladder diagram language (LD) .... 6 – 10
  A Sum Function in FBD Language ............................ 6 – 12
  I/O Signal Configuration Parameters ....................... 6 – 15
  Timers in LD/FBD/IL .......................................... 6 – 16
  Sequential Function Chart Language ......................... 6 – 22
S7 Checking PLC Programs (syntax check) ...................... 6 – 34
S8 Configuring Tasks ............................................... 6 – 35
S9 Compiling Projects ............................................. 6 – 37
S10 Communications Port Setup ................................... 6 – 38
S11 Downloading Programs to the PLC ......................... 6 – 39
S12 Monitoring Programs .......................................... 6 – 40
S13 Uploading Data from the PLC ............................... 6 – 42
Chapter 7: Sample Program: CarPark ........................................ 7 – 1
  Project Structure ......................................................... 7 – 1
  The Task ‘Main’ ......................................................... 7 – 2
  The Task ‘Door_Operate’ .............................................. 7 – 2
  Create the new ‘CarPark’ project .................................... 7 – 3
  Create the tasks ....................................................... 7 – 3
  Declare the global variables .......................................... 7 – 3
  Create the program organisation units ............................ 7 – 4
  Project Navigator Window ........................................... 7 – 4
  Program the headers .................................................. 7 – 5
    Header of the ‘Control’ POU ...................................... 7 – 5
    Header of the ‘Counter’ POU ..................................... 7 – 6
    Header of the ‘Door_Control’ POU ............................... 7 – 6
  Program the bodies ................................................... 7 – 7
    Body of the ‘Control’ POU ........................................ 7 – 7
    Body of the ‘Counter’ POU ....................................... 7 – 9
    Body of the ‘Door_Control’ POU ................................. 7 – 10
  Configure the tasks .................................................. 7 – 12
    The ‘Main’ task .................................................... 7 – 12
    The ‘Door_Operate’ Task ........................................ 7 – 13

Chapter 8: Importing ..................................................... 8 – 1

INDEX
Introduction

This manual...

...is a compact guide to using MELSEC MEDOC plus, suitable both for beginners and experienced users upgrading from other systems. The manual includes explanations of the terms and structural concepts of IEC programming and an introduction to the new IEC 1131.3 standard. The ‘Getting Started’ chapter provides a precise step-by-step description of how to use MELSEC MEDOC plus, including a sample project. This executable application is used to demonstrate the operation of the program with the help of the exercises provided in this manual.

The Reference Manual...

... contains detailed descriptions of all menus and menu options. Refer to it whenever you need more comprehensive information on the ins and outs of the system.

If you’re not yet familiar with MS Windows ...

... please at least read the Windows Fundamentals section in the Windows User’s Guide, or work through the Windows Tutorial accessible through the Help menu of the Windows Program Manager. This will teach you what you need to know about using the basic elements of MS Windows, and the operating procedures that are identical in all Windows application programs.

If you’re not yet familiar with the IEC 1131.3 standard...

... please do take the time to read the ‘Introduction to the IEC 1131.3 Standard’ chapter. This section explains the most important new terms and concepts of this industrial standard. A glossary of all the terms is provided in the Appendix of the Reference Manual.

If you already have IEC 1131.3 experience and want to get to work right away...

... then you can go straight to the ‘Getting Started’ section for immediate results. This chapter provides clear, step-by-step descriptions of all important MELSEC MEDOC plus operations, from creating a new project to downloading your finished program to the controller.
If you get stuck...

... don’t despair, help is never far away! If you run up against seemingly insoluble problems, or if you have questions about MELSEC MEDOC plus or the connected programmable logic controller (PLC) configuration, please first refer to the manuals and documentation. Many answers and solutions can also be found directly in the MELSEC MEDOC plus context-sensitive online help system, which can always be accessed by pressing I. Make use of the Search command in the Help menu as well, as this will often locate the information you need. If you can’t find answers to your questions in any of these places, contact your local MITSUBISHI ELECTRIC representative or call our European headquarters in Ratingen directly. The addresses and phone numbers are provided on the back covers of all our manuals.

Typographic Conventions and other Tips

In the rest of this manual MELSEC MEDOC plus will normally be referred to with the abbreviation MM+.

Menu names, menu commands, submenu commands and dialog box options are printed in boldface type, e.g. the menu command New in the Project menu, or the CPU Port and Computer Link (AJ71C24) options in the Transfer Setup dialog box.

These two symbols are used to identify the separate instructions for mouse and keyboard users.

Examples: This symbol identifies ‘how-to’ examples.

Note: This symbol draws your attention to notes, hints and valuable or useful information.

WARNING: Always pay particular attention to the warnings marked with this symbol. Failure to follow these instructions may lead to data loss, damage to your hardware or other serious problems.
Getting to Know MELSEC MEDOC plus

What’s New in MELSEC MEDOC plus?

- **MELSEC MEDOC plus is a Windows program**: MELSEC MEDOC plus uses the graphical user interface of MS Windows for fast, intuitive operation. This means that instead of laboriously searching through a labyrinth of program structures, you can implement your controller applications quickly and efficiently.

- **MELSEC MEDOC plus increases your productivity**: The modular architecture of MELSEC MEDOC plus brings big advantages for complex programming projects. Frequently-needed program blocks and functions only need to be created once. Thanks to the building block system you can then insert them again and again wherever and whenever required. This significantly reduces your programming overheads, enabling you to make major changes to your programs with just a few simple operations.

- **MELSEC MEDOC plus is a multi-language system**: MELSEC MEDOC plus supports programming in four different languages. Three graphical editors and one text-based editor help you to write tailor-made programs quickly and easily, choosing the language that best suits the problem.

- **MELSEC MEDOC plus is your link to the IEC world**: MELSEC MEDOC plus supports the new IEC 1131.3 standard for PLC (programmable logic controller) programming. This standard lays down the specifications for standardised PLC control programs.
Introduction to the IEC 1131.3 Standard

IEC 1131.3 is the new international standard for PLC programs, defined by the International Electrotechnical Commission (IEC). It defines the programming languages and structuring elements used for writing PLC programs.

Structured Programming

The structured programming approach replaces the former unwieldy collection of individual instructions with a clear arrangement of the program into individual program modules. These modules are referred to as Program Organisation Units (POUs), which form the basis of this new approach to programming.

There are three different classes of POUs, classified on the basis of their functionality:

- Programs
- Functions
- Function blocks

POUs declared as functions and function blocks are effectively programming instructions in their own right, and they can be used as such in every module of your programs.
The final program is assembled from the POUs that you define as programs. This process is handled by the task management, in the Task Pool. Program POUs are put together in groups referred to as **Tasks**.

The program POUs are grouped together in tasks.

In turn, all the tasks are grouped together to form the actual PLC program.
The Sequential Function Chart language (SFC) is also an aid for writing structured PLC programs. It is particularly well suited for programming sequential operations.

An SFC sequence consists of a series of steps and transitions (transition or continue conditions).

Programming Languages

The actual PLC program code contained in the program organisation units (POUs) and the steps and transitions of an SFC sequence can be written in any of the available programming languages. The language used will depend on the nature and size of the programming task.

- **The Text Editor:**
  Instruction List (IL)

- **The Graphical Editors:**
  Ladder Diagram (LD)
  Function Block Diagram (FBD)
Variables

Before you can actually start writing a PLC program you must first decide what variables you are going to need in the program module you are working on. Each POU has a list of local variables, which is where the variables that can only be used within that POU are defined and declared. The global variables, which can be used by all the POUs in the program, are declared in a separate list.

![Diagram of PLC program structure](image)
Getting to Know MELSEC MEDOC plus
Basic Terms Used in IEC 1131.3 Standard Programming

Projects

Every MM+ project consists of the following elements:

- The Library Pool:
  - the programming instructions contained in the standard library
  - the programming instructions contained in the manufacturer library
- The PLC parameters
- The tasks in the Task Pool
- The structured data types in the DUT Pool
- The global variables
- The program organisation units in the POU Pool

The program element objects are displayed in the Project Navigator window.
Program Organisation Units (POUs)

Each program organisation unit consists of

- a header
- a body.

The variables to be used in the POU are defined (declared) in the header. All the variables you are going to use must always be declared before you start programming. The body contains the actual PLC program.

POUs are divided into three classes on the basis of their functionality:

- Programs [PRG],
- Functions [FUN] and
- Function blocks [FB]
The program POU is the primary program organisation unit. Program POUs can contain programming instructions from libraries, functions and function blocks. The execution of the program POUs is controlled by tasks.

POUs declared as functions or function blocks are independent program elements. They function effectively as programming instructions that can be replaced whenever necessary, and they can also be used in other program modules, just like ordinary instructions.

Function blocks can be called by program POUs and other existing function blocks, but not from functions. The function blocks themselves can contain programming instructions from the libraries, functions and other existing function blocks.

Function blocks pass one or more output variables as their result. All the values of the output variables and the internal values within the function block are stored following execution of the function block. These values are then used the next time the function block is invoked. This means that invoking the same function block twice with the same input parameters does not necessarily result in the same output values!

Functions can be called by program POUs, function blocks and other existing functions. Functions can contain programming instructions from the libraries and other existing functions.

Functions can only pass one output value, and they do not store any internal status information. Thus, you should always get the same output value every time you invoke a function with the same input parameters.
### Differences: Function Blocks – Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Function Block</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal variable storage</td>
<td>Storage</td>
<td>No storage</td>
</tr>
<tr>
<td>Instancing</td>
<td>Required</td>
<td>Not required</td>
</tr>
<tr>
<td>Outputs</td>
<td>No output</td>
<td>One output</td>
</tr>
<tr>
<td></td>
<td>One output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multiple Outputs</td>
<td>One output</td>
</tr>
<tr>
<td>Repeated execution with same input values</td>
<td>Does not always deliver the same output value</td>
<td>Always delivers the same output value</td>
</tr>
</tbody>
</table>

### Parameters and Instancing

Functions and function blocks have formal parameters and actual parameters. **Formal parameters** are the variables used when a function or function block is created. The formal parameters of the programming instructions in the standard and manufacturer libraries are not visible to the user. **Actual parameters** are the variables that are passed to the function or function block instance (copy) when it is used in another POU. Actual parameters can be defined variables, hardware addresses or constants.

The program organisation unit POU_9 is a function block [FB]. The variables ‘IN’ and ‘OUT’ used in this program module are declared in the header. ‘IN’ and ‘OUT’ are the formal parameters.
Function blocks can only be called as instances. The process of 'instancing', or making a copy of the function block, is performed in the header of the POU in which the instance is to be used. In this header the function block is declared as a variable and the resulting instance is assigned a name. Note that you can declare multiple instances with different names from one and the same function block within the same POU. The instances are then called in the body of the POU and the actual parameters are passed to the formal parameters. Each instance can be used more than once. For details on activating instances of function blocks in the individual editors please refer to the chapter 'Programming Languages'.

Reset is an instance of function block POU_9.

'IN' and 'OUT' are the formal parameters; 'TimerS1' and 'ComeIn' are the actual parameters of the instance.
Tasks

A **task** contains one or more program organisation units declared as programs [PRG]. The task controls the processing of these programs by the controller.

This project consists of two tasks, **TASK_1** and **TASK_2**.

If a project contains more than one task you can define execution conditions for the individual tasks:

- **Event**: Execute on the rising edge of a variable
- **Interval**: Execute at defined time intervals
- **Priority**: Execute in a defined priority order

---

*MELSEC MEDOC plus Beginner’s Manual*
Variables

Variables are similar to operands. They contain the values of inputs, outputs or the internal memory locations of the PLC system.

A distinction is made between two different variable types, on the basis of their ‘scope’ within the program as a whole:

- Global variables, and
- Local variables.

Global variables are created for the entire project. They have global scope; this means that they are accessible from all POUs, thus making it possible to exchange data between the individual modules that make up the entire PLC program project.

Local variables’ scope only applies for a single specific POU. They cannot be used or referenced in other POUs.

Declaring Variables

Before you can begin with the actual programming, you must declare all the variables you are going to use in the project as a whole (global variables) and in the individual POUs (local variables).

Each variable declaration has the following elements:

- Class,
- Autoextern option (global variables only),
- Identifier,
- Absolute address (global variables only),
- Data type,
- Initial value (automatically),
- Comment (optional).

<table>
<thead>
<tr>
<th>POU 9 [FB] Header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
</tr>
<tr>
<td>VAR_INPUT</td>
</tr>
<tr>
<td>VAR_OUTPUT</td>
</tr>
</tbody>
</table>

The declaration table for local variables in the header of the POU_9 function block
Class

The class keyword assigns the variable a specific property that defines how it is to be used in the project.

<table>
<thead>
<tr>
<th>Class</th>
<th>Use in POUs:</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PRG</td>
<td>FUN</td>
</tr>
<tr>
<td>VAR</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>VAR_CONSTANT</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>VAR_INPUT</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>VAR_OUTPUT</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>VAR_IN_OUT</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>VAR_EXTERNAL</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>VAR_EXTERNAL_CONSTANT</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>VAR_GLOBAL_CONSTANT</td>
<td>X</td>
<td>-</td>
</tr>
</tbody>
</table>

Identifiers and Absolute Addresses

Each variable is given a symbolic address, i.e. a name. This is referred to as the **identifier**; it consists of a string of alphanumeric characters and underline characters. The identifier must always begin with a letter or an underline character. Spaces and mathematical operator characters (e.g. +, -, *) are not permitted.

**Examples of identifiers:**
- FAULT
- ZEROSIG
- LIM_SW_5

When global variables are declared they must also be assigned **absolute addresses** that reference the memory location of the variable in the CPU or a physical input or output.

When local variables are declared in the header of the POU they are automatically assigned a suitable memory location in the CPU.

You can use either the IEC syntax (IEC-Addr.) or the MITSUBISHI syntax (MIT-Addr.) to assign the absolute addresses. Two address columns are available.
As soon as you have entered an address in one of these columns, the other address also appears. You can enter either of the two address formats in both columns. If, for instance, you enter a MITSUBISHI address in the IEC column, MM+ identifies it immediately, places it in the correct column and produces the matching IEC address in the other column.

**Examples of absolute addresses:**

<table>
<thead>
<tr>
<th>IEC Address</th>
<th>MITSUBISHI Address</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%QX0</td>
<td>Y0</td>
<td>Output Y0</td>
</tr>
<tr>
<td>%IX31</td>
<td>X1F</td>
<td>Input X1F</td>
</tr>
<tr>
<td>%MW0.450</td>
<td>D450</td>
<td>Data register D450</td>
</tr>
</tbody>
</table>

Use upper case letters only and no spaces or mathematical operator characters (e.g. +, -, *) in addresses.

**Data Types**

The data type of a variable defines the number of bits it contains, how they are processed and the variable’s value range. The following data types are available.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Value range</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>0 (FALSE), 1 (TRUE)</td>
<td>1 bit</td>
</tr>
<tr>
<td>INT</td>
<td>-32,768 to 32,767</td>
<td>16 bits</td>
</tr>
<tr>
<td>DINT</td>
<td>-2,147,483,648 to 2,147,483,647</td>
<td>32 bits</td>
</tr>
<tr>
<td>WORD</td>
<td>0 to 65,535</td>
<td>16 bits</td>
</tr>
<tr>
<td>DWORD</td>
<td>0 to 4,294,967,295</td>
<td>32 bits</td>
</tr>
<tr>
<td>REAL</td>
<td>3.4 +/- 38 (7 digits)</td>
<td>32 bits</td>
</tr>
<tr>
<td>TIME</td>
<td>T#-24d-0h31m23s648.00ms to T#24d20h31m23s647.00ms</td>
<td>32 bits</td>
</tr>
<tr>
<td>STRING (Q series only)</td>
<td>Character string</td>
<td>max. 50 characters</td>
</tr>
</tbody>
</table>

**Initial Value**

The initial values are set automatically by the system and cannot be changed by the user.

**Comment**

You can add a comment up to 64 characters long for each variable.

**Autoextern option**

Global variables activated in the Autoextern column are automatically added to all existing and new POUs (programs and function blocks only).
Programming Languages

MELSEC MEDOC plus supports four programming languages: one text language, two graphical languages and a structuring language.

- Text language:
  - Instruction List language IL (IEC IL and MELSEC IL)

- Graphical languages:
  - Ladder Diagram language LD
  - Function Block Diagram language FBD

- Structuring language:
  - Sequential Function Chart language SFC

**WARNING:** You cannot change the programming language once you have selected it. Even though it is physically possible to switch to another language, you will lose the entire contents of the unit’s body if you attempt to do so!

Networks

In all the editors – with the exception of the SFC editor – your PLC program is divided into a number of program sections referred to as **networks**. Each network is assigned a name (the network label) which can be used as a destination for jump (goto) instructions.

**Note:** Each network can contain no more than one contiguous circuit unit.

The Text Editors

Two different instruction list types are supported:

- MELSEC Instruction List
- IEC Instruction List

The structure of both these instruction list types is identical. Each instruction list consists of a sequence of controller instructions. Each controller instruction begins on a new line and consists of a programming instruction and its parameters and variables. However, there are significant differences in the way the controller instructions are executed.
The MELSEC Instruction List Language (MELSEC IL)

MELSEC instruction list programs are written following the rules of DIN 19239 and the programming rules familiar from the MELSEC MEDOC software. You can only use genuine MELSEC programming instructions (see Appendix of the Reference Manual). MELSEC instruction list programs can only contain MELSEC networks. Access to IEC programming instructions is not possible.

The IEC Instruction List Language (IEC IL)

The IEC instruction list language allows you to combine IEC networks and MELSEC networks in a single program.

The IEC networks are programmed according to the IEC 1131.3 rules, and you can use both IEC programming instructions and the adapted MELSEC instructions (see Appendix in Reference Manual).

- **MELSEC network**
- **Network label** To enter the network label ‘NET_01,’ first double-click on the network bar.
- **IEC network**
- **Network bar**
- **Comment text must be enclosed between (* and *) character pairs.**
- **The ‘CJ’ instruction performs a jump to the specified destination network.**
The Accumulator

In the IEC editor the result of each operation is stored in an **accumulator** directly after execution. This accumulator always contains the operation result of the last instruction programmed.

**Note:** You do not have to program input conditions (execution conditions) for the operations in this editor. Execution is always based on the contents of the bit accumulator.

**Example:** The following illustrates the difference between programming in the MELSEC and IEC editors. We want to program the addition D0 (5) + D1 (10) = D2 (15) to be executed when input X0 is active.

1. The bit accumulator is undefined at the beginning of the network.
2. The accumulator now contains a value of 0 or 1, depending on the state of input X0.
3. The JMPCN instruction (JumpConditionalNot) will be executed if the value in the accumulator is 0. The instructions in section 4 are skipped and the program branches to the ‘Next:’ network. If the value in the accumulator is 1, JMPCN is ignored and the instructions in 4 are executed. The accumulator then still contains the status of X0, i.e. 1 in this case.
4. Writes the contents of data D0, i.e. 5, to the accumulator.
5. Adds the value in D0 to the value in D1. After the addition the result (15) is stored in the accumulator.
6. Stores the result of the addition to D2. The accumulator still contains the value 15.
Calling Function Blocks

Function blocks can only be called as instances, using the following operators:

- **CAL** (Call)
- **CALC** (CallConditional)
- **CALCN** (CallConditionalNot)

CAL is always executed. CALC and CALCN first poll the status of the bit accumulator; they are executed only if its value is 1 (CALC) or 0 (CALCN).

The instance name is assigned in the header of the POU. The actual parameters must then be passed to the formal parameters in the code programmed in the body.

### Example

#### POU_9 [PRG] Header

<table>
<thead>
<tr>
<th>Class</th>
<th>Identifier</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR</td>
<td>Reset</td>
<td>POU_9</td>
<td>Instance</td>
<td></td>
</tr>
</tbody>
</table>

#### POU_9 [PRG] Body [IL]

- LD TimerS1
- ST Reset
- LD Comeln
- ST Reset
- CAL

There are two ways (2 and 3) to pass actual parameters to formal parameters.

1. Declares the instance 'Reset' of function block POU_9.
2. The formal parameters of function block POU_9 are 'IN' and 'OUT'. Actual parameters 'TimerS1' and 'Comeln' are passed to these formal parameters.
Calling Functions

When you call a function, you must pass the necessary actual parameters to its formal parameters.

A total of \( n - 1 \) actual parameters are assigned to every function, where \( n = \) total number of function parameters. This is because the first parameter must always be written to the bit accumulator with the LD instruction.

Example:

The ‘Average’ function is programmed to perform the following operation:

\[
(D0 + D1 + D2 + D3) : 4.
\]

When the function has been executed the bit accumulator contains the resulting average value of the four input parameters.

LD must also be used to pass the first parameter for the EN/ENO functions (e.g. E_ADD, E_MUL, E_XOR). Their first parameter is always the Boolean EN input (EN = ENable).

Example:

The ‘E_ADD’ function performs the following operation:

\[
D0 + D1 = D2.
\]

Following execution of this function the bit accumulator will contain the status of the ENO output (ENO = ENable Out), which in term has the same status as the EN input.
The Graphical Editors

The Ladder Diagram Language (LD)

You can use all available programming instructions in the ladder diagram language (see Appendix in Reference Manual).

Ladder diagrams consist of contacts (break and make contacts), coils, function blocks and functions. These elements are linked with horizontal and vertical lines, referred to as interconnects. These interconnects always begin at the power bar on the left, which is sometimes also referred to as the rail.

**Note:** Each network can contain no more than one contiguous circuit unit.

The functions and function blocks are displayed as shaded blocks in the editing window. In addition to their input and output parameters, some also have a Boolean input (EN = ENable) and a Boolean output (ENO = ENable Out).
Calling Function Blocks

Function blocks can only be called as instances. The instance name must be declared in the header of the POU.

In the ladder diagram editor, the name of the function block is displayed inside the shaded block. The instance name declared in the header must be entered directly above the block. Then the actual parameters must be passed from outside to the formal parameters shown inside the block.

Calling Functions

When you call a function you must pass the necessary actual parameters (outside the shaded block) to the formal parameters (shown inside the block) (cf. 4 in the illustration above).
The Function Block Diagram Language (FBD)

In the function block diagram language you can also use all programming instructions (see Appendix in Reference Manual). They are displayed as shaded blocks which are connected with the horizontal and vertical interconnect lines. Power bars are not used in this language.

In addition to the normal input and output parameters some blocks also have a Boolean input (EN = ENable) and a Boolean output (ENO = ENable Out).

Calling Function Blocks and Functions

In the function block language, function blocks and functions are called in exactly the same way as in the ladder diagram language.
The Sequential Function Chart Language (SFC)

SFC is a structuring language which allows clear representation of complex processes.

**Note:** The program is the only available program organisation unit (POU) in this language.

The basic elements of the SFC language are steps and transitions. From 0 to n actions can be assigned to each step. An action can be a Boolean variable (output or relay) or a PLC program. These programs can be written using any of the editors – including the sequential function chart language itself. All actions are listed in the Action Pool in the Project Navigator window. Each transition is assigned a transition condition. Transition conditions can be written using any of the editors – except sequential function chart itself. All transitions are also listed in the Project Navigator window. Transitions pass control to the next step in the program sequence when their condition evaluates as logical true.

Assignment of actions to steps and of transition conditions to transitions is performed with the following toolbar icons:

- **Activate action/transition condition**
- **Deactivate action/transition condition**
Sequencing Rules

A sequence always begins with an Initial Step, identified by a double outline. The initial step does not have to be at the physical beginning of the sequence, it can also be placed in other locations.

Steps are displayed as shaded blocks with names. Transitions are shown as small boxes placed directly on the vertical connecting lines between the steps.

Only one step can be active at any one time; this also applies in sequences with selective branching. A step is activated when the directly preceding step is deactivated and the transition condition (i.e. the continue condition) is satisfied. If the continue conditions of two or more transitions are fulfilled at the same time in a sequence with selective branching, execution priority is defined by the order of the sequences from left to right. This means that only the sequence that is furthest to the left will be executed. Even if their continue conditions are satisfied, the sequences further to the right will not be executed.

Graphical programming in the sequential function chart editor

1. Initial step
2. Step
3. Transition
4. Jump exit point
5. Jump entry point
6. Final step
Sequences can also contain left and right ‘divergences’ and ‘convergences’ (i.e. alternative branches for different transition conditions). These branches are identified by a double horizontal interconnect lines.

Jumps are also allowed within sequences. These are effected with exit points (jump instructions) and entry points (labels).

Every step can be declared as a macro step, consisting in turn of a sequence. Macro steps are identified by two additional horizontal lines within the block. The only limitation on the nesting depth is the memory capacity of the controller.

**Note:** You will find more detailed information on the sequencing rules of the SFC language in the Reference Manual. You can find a detailed example in Chapter 6 of this manual (Step S6).
Installation

Hardware Requirements with MS Windows 3.1

Minimum Hardware Configuration

- 80386DX processor or above
- 4 MB RAM
- Hard disk with at least 20 MB free
- 3,5" high density floppy disk drive
- VGA-compatible graphics adapter
- Mouse
- 1 RS232 serial port for communication with the PLC system
- 1 printer port
- Printer
- 14"/35 cm diag. VGA monitor

Recommended Enhancements

- Pentium
- 8 MB RAM
- 1024 x 768 x 256 (width x height x colour depth)
- Small Fonts
- 17"/43 cm diag. VGA monitor

Software Requirements

- MS-DOS operating system version 3.3 or above
- Microsoft Windows version 3.1*/Microsoft Windows 95 (16 bit)

Copyright

IMPORTANT NOTICE: This software is protected by copyright. By opening the distribution disks package you automatically accept the terms and conditions of the License Agreement. You are only permitted to make one single copy of the original distribution disks for your own backup and archiving purposes.

Installing MELSEC MEDOC plus

During this procedure the installation program will create a directory on your hard disk, into which all the MM+ files will be copied.
4 – 2 Installation

**Installing MM+ on your hard disk**

1. Before you begin, make backup copies of the MM+ distribution disks. Write-protect the disks to make sure they cannot get erased accidentally. Install the program from the backup copies and store the original disks in a safe place.

2. Make sure that Microsoft Windows 3.1* is properly installed on your computer. For information on using Windows please refer to the Windows User’s Guide.


4. Insert Installation Disk 1 in the floppy disk drive.

5. Open the Windows File Manager.

6. Select and open the floppy disk drive in which you have inserted the installation disk.

7. Double-click on the file INSTALL.EXE.

   This starts the MM+ installation program.

8. Follow the instructions that appear on the screen.

9. When the installation procedure is finished the program will create a new program group containing the MM+ program icon.

   For further details on the necessary Windows procedures please refer to your Windows documentation.

**Starting MELSEC MEDOC plus**

1. Double-click on the MM+ program icon. This starts MELSEC MEDOC plus and displays the start-up screen.

2. Confirm with the <Enter> key.

**Quitting MELSEC MEDOC plus**

You can quit MM+ directly at any point in the program by pressing the key combination <Alt> + <O>.

Or:

Double-click on the Quit command in the Project menu.
The User Interface

The Elements of the User Interface

The Project Navigator window and the complete menu bar are both only displayed after opening an existing project or creating a new one (see S1 in chapter 6 ‘Getting Started’). The illustration below shows a variety of different windows: The Project Navigator, PLC Parameter and the Header and Body windows of a POU. You can resize and arrange the windows on the screen to suit your individual preferences.
The Menu Bar

The MM+ menu bar uses the standard Windows procedures. When you select one of the menu titles in the menu bar, a drop-down list of available commands is displayed. Commands with an arrow symbol open a submenu of additional commands. Selecting a command opens a dialog or data entry box. The menu structure and the available options are context-sensitive, changing depending on what you are currently doing in the program. Options displayed in light grey are not currently available for selection.

Note: A list of all menu commands with explanations is provided in the Appendix of the Reference Manual.

The Toolbar

The toolbar enables you to select the most important menu commands directly by clicking on the corresponding icons. The toolbar is context-sensitive, i.e. different tool icons are displayed depending on what you are currently doing in MM+.

Note: A complete list of all the available tools and icons is provided at the end of the Reference Manual.

Windows

MM+ allows you to edit multiple objects at the same time (e.g. body, header, task). A window is opened on the screen for each object. You can change the size and position of the windows on the screen as you wish. Objects often contain more information than can be displayed in the window; when this happens, horizontal and vertical scroll bars are included that can be used to ‘scroll’ the contents of the windows up and down and from side to side.

The Status Bar

The status bar at the bottom of the screen is used to display information on the current status of your project. You can disable the status bar if you wish, and you can also configure the information to be displayed to suit your needs.

The Project Navigator

The Project Navigator is the ‘control centre’ used for selecting and handling the objects used in MM+. This is the starting place for all operations performed on MM+ objects. The Project Navigator window is not displayed until you open a project. Closing the Project Navigator window automatically closes the project currently on screen.
Using the Project Navigator

You can expand or collapse branches of the Project Navigator tree by double-clicking on the appropriate levels. Expanded and collapsed branches are identified by different arrow symbols in the tree. Double-clicking on the lowest level opens the window of the object on that level.

'Manoeuvering' with the Project Navigator

You can only perform the Cut, Copy, Paste and Delete operations on POU and Task objects. You can copy and delete multiple objects at the same time. To select individual multiple objects, hold down the CTRL key and click on the objects one after the other with the left mouse button. To select a consecutive group of multiple objects, first select the first object with a single click, then hold down the SHIFT key and click on the last object in the list you want to select.

Note: The Extended Information command in the View menu enables or disables the display of additional information with the items in the Project Navigator window.

Declaration Tables

The local variables of program organisation units (POU Header) and global variables are defined in declaration tables.
Working with tables

You can access every cell in a table directly by clicking with the mouse. When the insertion mark (cursor) appears you are in editing mode and can make entries. You can move around in tables with the following keys and key combinations:

<table>
<thead>
<tr>
<th>Key</th>
<th>Movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>w</td>
<td>Line up</td>
</tr>
<tr>
<td>x</td>
<td>Cell right</td>
</tr>
<tr>
<td>y</td>
<td>Line down</td>
</tr>
<tr>
<td>z</td>
<td>Cell left</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>j</td>
<td></td>
</tr>
<tr>
<td>je</td>
<td>Insert new line</td>
</tr>
</tbody>
</table>

You can also add new lines to a table with the New Declaration command from the Edit menu. You can insert a new line at the beginning, end of the table or before or after the current line.

Deleting Tables and Lines

Clicking on one of the shaded line number boxes at the left selects the corresponding line. Clicking on the empty uppermost box in the number box column selects the entire table. You can then delete the selected line or table by pressing the DEL key.

Note: The program performs these delete operations immediately, without prompting for confirmation. If you inadvertently delete something you can recover it by selecting the Undo command in the Edit menu. Undo only works if you select it directly after the delete operation, however!

Formatting Tables

You can adjust the width of the table columns to suit your individual needs. Move the mouse pointer to the dividing line between the shaded column title boxes, so that the pointer changes to a double-headed arrow. Then press and hold the left mouse button and drag the shaded dividing line until the column has the desired width.
The Editors

Your PLC programs are always divided into a number of logical program sections – referred to as ‘networks’. These networks can be assigned names (labels) which can then be used as jump destinations within the PLC program. New networks are inserted with the New Network command in the Edit menu.

To open an editing window, simply double-click on a Body entry in the Project Navigator window.

Text Editors

- IEC Instruction List
- MELSEC Instruction List

Graphical Editors

- Ladder Diagram
- Function Block Diagram
- Sequential Function Chart

Please refer to the Reference Manual for full details on using the SFC language.

Using the text editors

All cursor movements and editing functions are similar to those of a standard word processor. The following additional conventions also apply in the text editors:

- To activate editing mode, click on the surface of a network with the mouse pointer.
- Each program line contains one controller instruction, with the following syntax:
  
  Operator  TABSTOP Operand(s)

- The operator and the operands must always be separated by tabstops.
- Pressing F2 when the cursor is in the first column displays a list of available programming instructions; pressing it in the second column displays a list of available operands (variables).
- You can also enter optional comments, which can be one or more lines long. Comments must be enclosed between (* and *) characters.
- You can move around in the program lines with the normal cursor keys.
**Using the graphical editors**

Working in the graphical editors is similar to using a drawing program. You can add elements to the networks in the editing windows by selecting symbols in the toolbar and with the commands in the *Tools* menu. The following elements are available:

- Contact (input, LD only)
- Coil (output, LD only)
- Programming instructions
- Input variable
- Output variable
- Return instruction
- Jump label
- Comment

Once you have positioned the elements, you then connect them with one another using interconnect lines.

**Note:** In Chapter 6 (Step 56) you will learn how to use the different editors.
Getting Started

This chapter contains an introductory outline of all the steps required to create a new project with MM+, with clear instructions on the procedures necessary in each step.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1 Creating New Projects</td>
<td>6 – 2</td>
</tr>
<tr>
<td>S2 Creating Tasks</td>
<td>6 – 4</td>
</tr>
<tr>
<td>S3 Declaring Global Variables</td>
<td>6 – 5</td>
</tr>
<tr>
<td>S4 Creating Program Organisation Units</td>
<td>6 – 7</td>
</tr>
<tr>
<td>S5 Programming POU Headers</td>
<td>6 – 8</td>
</tr>
<tr>
<td>S6 Programming POU Bodies</td>
<td>6 – 9</td>
</tr>
<tr>
<td>S7 Checking PLC Programs (syntax check)</td>
<td>6 – 34</td>
</tr>
<tr>
<td>S8 Configuring Tasks</td>
<td>6 – 35</td>
</tr>
<tr>
<td>S9 Compiling Projects</td>
<td>6 – 37</td>
</tr>
<tr>
<td>S10 Communications Port Setup</td>
<td>6 – 38</td>
</tr>
<tr>
<td>S11 Downloading Programs to the PLC</td>
<td>6 – 39</td>
</tr>
<tr>
<td>S12 Monitoring Programs</td>
<td>6 – 40</td>
</tr>
<tr>
<td>S13 Uploading Data from the PLC</td>
<td>6 – 42</td>
</tr>
</tbody>
</table>

Programming examples:
- Inputs and outputs in LD
- Sum function in FBD
- I/O signal configuration parameters
- Timers in LD/FBD/IL
- Sequential function chart language
Creating New Projects

How to create a new project

1. Select New in the Project menu.

2. This displays the PLC Parameter dialog box. Select your PLC in the PLC Type field and confirm your selection with OK.

3. The New Project dialog box is displayed. Select or enter the path under which you wish to store the new project.

4. Enter a name for the new project at the end of the path (the project name is also the name of the subdirectory/folder in which it is stored). When you are satisfied, click on the Create button to create the project.

In this example a project called PROJ_NEW is being created in the subdirectory C:\mmp_proj. Please note that PROJ_NEW is not a single file, but rather a subdirectory created by MM+ to contain all the project files.
Click on the **Standard** option button in the **Project Wizard** dialog box.

MM+ then creates the new project as defined.

As soon as you have created a new project the Project Navigator window is displayed on the screen automatically with all the standard entries for the project.

The project entries are displayed in a hierarchical tree structure, which always contains the following standard components:

- Project Name
- Library Pool
- PLC Parameters
- Task Pool
- Data Unit Types Pool
- Global Variables
- Program Organisation Units

Additional information is displayed in brackets after each entry in the Project Navigator window. You can disable the display of these details by clicking on **Extended Information** in the **View** menu (a ✓ check mark is displayed next to the option when it is enabled).

The standard MM+ window background colour is light grey. You can change all the colours to suit your personal taste with **Colors** in the **View** menu.
How to define a new task

① Select the Project Navigator window.

② Select New in the Object menu, then select the Task option.

Or

Click on the New Task icon in the toolbar:

The New Task dialog box is displayed.

③ Enter a name (max. 16 characters) for the new task and confirm with OK. MM+ then creates the task and displays the name in the Task Pool in the Project Navigator window.

Note: Assignment of the program organisation units (POUs) to the tasks and definition of the task attributes will be performed later on in Step S8.
S3——— Declaring Global Variables ———————————————— S3

How to declare global variables

① Double-click on the Global_Vars branch in the Project Navigator. This opens the Global Variable List window on the right hand side of the screen, containing the declaration table for entry of the variables.

<table>
<thead>
<tr>
<th>Class</th>
<th>Autotextm</th>
<th>Identifier</th>
<th>MIT-Addr.</th>
<th>IEC-Addr.</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_GLOBAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

② Click in the first cell in the Class column with the mouse cursor, then click on the up arrow button and select VAR_GLOBAL or VAR_GLOBAL_CONSTANT.

③ Press | (Tab) to move to the Identifier column, then enter the identifier for your first global variable.

④ Press | to move to the MIT-Addr. or IEC-Addr. column. Enter the absolute address of the global variable.

⑤ Press | to move to the Type column and click on the up arrow button with the mouse to open the Type Selection dialog box.

⑥ Select Simple Types in the Type Class field.

⑦ Select the appropriate data type from the list on the left.
The initial value in the **Initial** column is assigned automatically and cannot be changed by the user.

⑧ If you want to enter a comment text for the variable press | to move to the **Comment** column, then enter your text.

⑨ To enter another variable,

- If the editing cursor is active in the Comment column (white background with blinking cursor) you can create a new variable declaration line by pressing | (Tab).

```
<table>
<thead>
<tr>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>
```

Or

- Select any cell in the last line of the table and press Je.

```
<table>
<thead>
<tr>
<th>Class</th>
<th>Autostart</th>
<th>Identifier</th>
<th>MIT-Addr</th>
<th>IEC-Addr</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR GLOBAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Or

- Select **New Declaration** in the **Edit** menu and then select the position in which it is to be inserted from the submenu.

Or

- Copy an existing declaration line: First select the line by clicking on its number button at the left, then press bC to copy it to the clipboard. Then select the insertion position by clicking on the appropriate number button and press bV to insert.

⑩ Save your new entries with **Object - Save**.

**Note:** The terms **identifier**, **address** and **data type** are defined and explained in Chapter 3.
Creating Program Organisation Units

Program organisation units (POUs) always consist of two main parts, a header and a body.

How to create a new program organisation unit

1. Click on the New POU icon in the toolbar:

![New POU icon]

**Note:** This tool icon is only displayed in the toolbar when the Project Navigator window is displayed on the screen, i.e. when a project is open.

2. Enter a name for the new POU and specify whether it is to be created as a program (PRG), a function (FUN) or a function block (FB). Then select the programming language/editor to be used for the creation of the PLC program in the POU’s body. When you are satisfied that all your entries are correct select OK to add the new POU to the project.

![New POU window]

A new POU called ‘Control’ is being defined and declared as a ‘Program’ (PRG) type.

The PLC program in the body of the POU is going to be written in ladder diagram language.

The new ‘Control’ POU is then added to the project and appears in the POU Pool in the Project Navigator window.

![POU Pool]

The right arrow symbol to the left of ‘Control’ in the project tree indicates that this entry has subordinate entries that are currently collapsed. The asterisk in front of the term ‘Control’ indicates that this POU has not yet been compiled.

3. Double-click on ‘Control’ to open the subordinate entries.

![POU Pool]

Every POU has two main components: a header and a body containing the actual program in the selected programming language.
The POU header is used to declare and store the variables used by the program that the POU contains. In addition to global and local variables, these declarations can also include instances of function blocks.

**How to program the POU header**

1. Check that the Header and Body entries are displayed under the POU entry in the POU Pool and expand them if necessary (see 3 in S4).

2. Double-click on the ‘Header’ entry in the Project Navigator window. This opens a window containing the declaration table for the header’s local variables on the right hand side of the screen.

3. To declare the variables, proceed in exactly the same way as with the global variables in S3 above, entering the class, identifier and data type for each variable.

4. Select **Save** in the **Object** menu to store your entries.

**Note:** If you wish to enter global variables in the header you can copy them from the global variables declaration table (bC) and then insert them in this declaration table (bV).

The terms **class**, **identifier** and **data type** are defined and explained in Chapter 3.
The body contains the actual code of the PLC program. The programming language used is shown in the information in brackets following the 'Body' entry in the project tree.

How to program the POU body

1. Check that the Header and Body entries are displayed under the POU entry in the POU Pool and expand them if necessary (see 3 in S4).

2. Double-click on the 'Body' entry in the Project Navigator. The editing window of the editor for the selected programming language is opened on the right hand side of the screen. It contains one network.

3. Now you can start writing your PLC program.

You will find programming examples for the various programming languages and editors on the following pages.

4. Select Save in the Object menu to save the body of your POU.

Note: You can increase the size of the editing area with the mouse. Position the mouse pointer on the lower edge of the network bar box at the left of the editing window (the pointer changes to a double arrow when it is over the resize line). To resize the editing area, hold down the left mouse button, drag the dotted line to the desired position and then release the button.
Programming Examples

Inputs and outputs in ladder diagram language (LD)

Programming inputs and outputs in the LD editor

1. In the Project Navigator window, double-click on a program body entry defined with the ladder diagram language (LD).

2. Click on the “Contact” tool icon in the toolbar.

3. Move the mouse pointer to the desired position and press the left mouse button to place the input contact.

4. Click on the “Coil” tool icon in the toolbar.

5. Move the mouse pointer to the desired position and press the left mouse button to place the output coil.
The ‘VAR’ designations that appear above the input contact and output coil symbols are dummy names, which you must replace with declared operand names or a direct address (X, Y).

Click on the "Interconnect/Line" tool icon in the toolbar or

Click with the right mouse button.

Position the pointer over the left network bar, hold down the left mouse button and draw a line to the connection point of the output coil.

The ‘VAR’ designations that appear above the input contact and output coil symbols are dummy names, which you must replace with declared operand names or a direct address (X, Y).

Click on the ‘Select mode’ tool icon in the toolbar. Using the mouse pointer, select the ‘VAR’ dummy designators over the contact and the coil and overwrite the dummy name ‘VAR’ with appropriate variable names. Alternatively, you can also press m to display the operand selection list and select a name from the list.
A Sum Function in FBD Language

**Programming a sum function in the FBD editor**

Steps 1 through 5 below are exactly the same in the ladder diagram and function block diagram editors. Only the tools displayed in the toolbar are different in each case.

1. In the Project Navigator window, double-click on a body entry defined with the function block diagram language (FBD).

2. Click on the “Function Block” tool icon in the toolbar.

3. Double-click on the ADD instruction in the selection box displayed.

4. Position the mouse pointer and press the left mouse button to place the function block.

5. Click on the “Input Variable” tool icon in the toolbar.
Position the mouse pointer next to the block’s first input and press the left mouse button. Repeat step 6, and then enter the next input variable next to the block’s second input.

Click on the “Output Variable” tool icon in the toolbar.

Position the mouse pointer next to the output of the block and press the left mouse button.

Click on the ‘Var’ dummy designators of the input variables and overwrite the first with a value of 12 and the second with 8.
Click on the ‘Var’ dummy designator of the output variable and then press m to display the operand list. Select ‘Sum’ and confirm with OK.

**Note:** The variables will only appear in the operand list if the header in which they are declared has been saved.

Click on the “Interconnect/Line” tool icon in the toolbar. (In the illustration the “Var” dummy designators of the input variables have been overwritten with two constants, and the variable designator “Sum” has been entered for the output variable.

Draw an interconnect line between the first input variable and the output variable. Then draw a line to connect the second input variable to the function block.
I/O Signal Configuration Parameters

Setting the signal configuration parameters of inputs and outputs

1. Double-click on an input contact, an output coil or the connection point of a variable in a function block to display the Signal Configuration dialog box. Select the appropriate options, then confirm with OK.
   1. Negated input contact (LD only)
   2. Negated output coil (LD only)
   3. Set output coil (LD only)
   4. Reset output coil (LD only)
   5. Negated input variable (LD and FBD)
   6. Negated output variable (LD and FBD)
Timers in LD/FBD/IL

Description of the timer device

All timers must have the following four elements:

- **TValue**: Setpoint value
- **TN**: Actual value
- **TC**: Output coil
- **TS**: Input contact

The elements **TN**, **TC** and **TS** must be declared in the global variables list.

The element **TValue** is passed to the function directly.

The timer example

The following example shows how to program a timer and a function block instance (see Chapter 3) in ladder diagram, function block diagram and instruction list languages.

**Objective:**

When ‘Input1’ is set the 100-ms timer ‘Timer1’ must start to count and continue until it reaches a value of 100. We want ‘Output1’ to be set when ‘Input2’ is set, and we want ‘Output1’ to be reset again when the setpoint value of 100 is reached.

**Algorithm:**

‘Input2’ and the timer contact ‘Timer1S’ (TS) are responsible for switching ‘Output1’. This function will be performed by the user-programmed function block SET_RST.’

‘Input1’ activates the timer, i.e. it controls the switching of the timer coil ‘Timer1C’ (TC). The setpoint value TValue is 100. The timer function will be implemented by using the manufacturer function TIMER_M.
Creating the program

**Step 1: Program the function block SET_RST**

1. Create a POU called ‘SET_RST’ and define it as a function block to be programmed in ladder diagram language (see S4, p. 6–7).
2. Enter the following three variables in the header: SET, RST and Q.
3. Insert two network circuit blocks in the body.

   SET and RST are input variables (VAR_INPUT), Q is an output variable (VAR_OUTPUT).

4. Save the header and the body (Object - Save).
5. Select the ‘SET_RST’ POU in the Project Navigator window and press AE. The following dialog box is then displayed:

6. Activate the EN/ENO Contacts check box to assign an EN input and an ENO output to the function block.
Step 2: Define the global variables

The timer elements TC, TS and TN must first be declared in the global variable list. They can then be called in the header of the POU in which the timer is going to be used. In this example, the input and output variables are also declared globally.

1. Open the global variable declaration table (see S3).
2. Declare the following variables.

<table>
<thead>
<tr>
<th>Class</th>
<th>Identifier</th>
<th>Type</th>
<th>Initial</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_GLOBAL</td>
<td>TimerC</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>TimerS</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>TimerN</td>
<td>INT</td>
<td>0</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Enag1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Enag2</td>
<td>INT</td>
<td>0</td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Aoutg1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

Step 3: Create the Timer POU (ladder diagram)

1. Create a new POU as a program using the ladder diagram language (see S4).
2. Open the header of the new POU and declare the following variables:

<table>
<thead>
<tr>
<th>Class</th>
<th>Identifier</th>
<th>Type</th>
<th>Initial</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAREXTERNAL</td>
<td>TimerC</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAREXTERNAL</td>
<td>TimerS</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAREXTERNAL</td>
<td>TimerN</td>
<td>INT</td>
<td>0</td>
</tr>
<tr>
<td>VAREXTERNAL</td>
<td>Input1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAREXTERNAL</td>
<td>Input2</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAREXTERNAL</td>
<td>Output1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>VAR</td>
<td>DATA</td>
<td>INT</td>
<td>0</td>
</tr>
<tr>
<td>VAR</td>
<td>SET_RST1</td>
<td>SET_RST</td>
<td></td>
</tr>
</tbody>
</table>

Use global variables = VAR_EXTERNAL
Use as local variables = VAR
The variable SET_RST1 is an instance of the function block SET_RST (see Chapter 3 for details on instancing).
3. Save the header (Object - Save).
④ Open the body of the POU.

The timer we shall use is a function that is stored in the manufacturer library. The timer function is called **TIMER_M**.

You can find instructions on how to insert function blocks in the editing window in the section on "Sum Function in FBD" (p. 6–16).

⑤ Create the following PLC program:

The function blocks used in the program can be found in the following libraries:

**Manufacturer Library:**
- TIMER_M

**Function blocks:**
- SET_RST

**IEC Standard Library:**
- MOVE
**Timer sequence**

The timer sequence begins when INPUT1 is set and the timer starts to run. If INPUT2 is set, OUTPUT1 is switched on.

When the 10-second period has elapsed, timer contact TIMER1S is set and OUTPUT1 is switched off again.

The lower program block containing the MOVE instruction is only necessary to make it possible to follow the 10-second sequence in monitoring mode.
Programming the timer in function block diagram language

The following illustration shows how to realize the same program using function block diagram language:

![Function block diagram]

Programming the timer in instruction list language

The following illustration shows how to realize the same program using instruction list language:

![Instruction list]

Note: Please refer to Chapter 3 for detailed instructions on how to call functions and pass the actual parameters to the formal parameters of function block instances in the instruction list language.
Sequential Function Chart Language

You can find a basic introduction to the SFC programming language in Chapter 3 of this manual. More detailed information is provided in the Reference Manual. The following example is a step-by-step illustration of the procedures required to create an SFC program using the MM+ tools.

The 'Process' sample program

The program is called 'Process' and solves the problem using a variety of selective branching constructs and the Jump instruction.
Program execution

1. When the PLC is switched to RUN mode ‘Output1’ is set.
2. The transition ‘TRAN_1’ performs a TRUE/FALSE poll of ‘Input1’. If ‘Input1’ is set ‘Step_1’ and ‘Step_1_a’ are both activated. ‘Output2’ blinks and ‘Output3’ is switched on continuously.
3. The transition ‘Input2’ polls ‘Input2’. If the latter is set ‘Step_2’ is executed and ‘Output4’ is set.
4. In the subsequent branches to ‘Input3’, ‘Input4’ and ‘Input5’ a variety of program sequences then execute in parallel.
   - If ‘Input3’ is set, this activates ‘Step_3’.
   - ‘Input5’ activates the jump exit point ‘Jump’ which leads to the jump entry point ‘Jump’ and also activates ‘Step_3’.
   - ‘Step_3’ sets ‘Output5’.
   - If ‘Input4’ is set, this triggers ‘Step_4’, which then switches ‘Output6’.
5. ‘Input6’ and ‘Input7’ lead to the end of the program.

Creating the program

Perform steps 1 through 8 in the order described.

Step 1: Create the POU

1. Create a new POU called ‘Process’. Select PRG (program) as the class and sequential function chart as the programming language (see S4).

   ![Diagram of POU structure]

   The new ‘Process’ POU is displayed in the Project Navigator. In addition to the header and the body, each POU written in SFC language also has an action pool entry in which the actions assigned to the POU are stored.
Step 2: Declare the variables in the header

1. Open the header and enter the variables to be used in the POU (see S3).

<table>
<thead>
<tr>
<th>Step</th>
<th>Class</th>
<th>Identifier</th>
<th>Type</th>
<th>Initial</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>VAR_EXTERNAL</td>
<td>Click pulse</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>1</td>
<td>VAR_EXTERNAL</td>
<td>Input1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>2</td>
<td>VAR_EXTERNAL</td>
<td>Input2</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>3</td>
<td>VAR_EXTERNAL</td>
<td>Input3</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>4</td>
<td>VAR_EXTERNAL</td>
<td>Input4</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>5</td>
<td>VAR_EXTERNAL</td>
<td>Input5</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>6</td>
<td>VAR_EXTERNAL</td>
<td>Input6</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>7</td>
<td>VAR_EXTERNAL</td>
<td>Input7</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>8</td>
<td>VAR_EXTERNAL</td>
<td>Output1</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>9</td>
<td>VAR_EXTERNAL</td>
<td>Output2</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>10</td>
<td>VAR_EXTERNAL</td>
<td>Output3</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>11</td>
<td>VAR_EXTERNAL</td>
<td>Output4</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>12</td>
<td>VAR_EXTERNAL</td>
<td>Output5</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>13</td>
<td>VAR_EXTERNAL</td>
<td>Output6</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
<tr>
<td>14</td>
<td>VAR_EXTERNAL</td>
<td>Output7</td>
<td>BOOL</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

In this example only global variables are used. Global variables are referenced by using the VAR_EXTERNAL class.

Step 3: Open the body

1. Double-click on the ‘Body’ entry in the Project Navigator window.

When you open the SFC editor the following elements are displayed:
- The Initial Step (double outline)
- The transition TRUE
- The Final Step

Note: Steps to which no actions are yet associated are shown filled in white. The fill colour changes to grey when actions are associated. Your current position in the sequence is indicated by a ‘block cursor’, displayed as a black rectangle around the elements that can be moved around at will in the editing window with the mouse or cursor keys. The tool icons activated in the toolbar change depending on the current position of this cursor; you cannot use all the tools at all positions in a program.
Step 4: Create the sequence

1. Select the ‘TRUE’ transition with the block cursor.

2. Click on the tool icon

   "Inserts a new step/transition pair."

3. Select the step you have just inserted.

4. Click on the tool icon

   "Inserts a right divergence and a new step."

5. Select the ‘TRUE’ transition.

6. Click on the tool icon

   "Inserts a right convergence."
Select the ‘TRUE’ transition.

Click on the tool icon

*Inserts a new step/transition pair.*

Select the ‘TRUE’ transition.

Click twice on the tool icon

*Inserts two right divergences with transitions.*
11. Select the ‘TRUE’ transition.

12. Click on the tool icon

   ![Tool Icon]

   *Inserts a new step/transition pair.*

13. Click in the empty space next to the step you have just inserted.
Click on the tool icon

*inserts a new step/transition pair.*

Click on the final step.

Click on the tool icon

*inserts a right convergence.*
Click on the left hand step in the bottom row.

Click on the tool icon

*Inserts a jump entry point.*

Click on the empty space below the free transition.
Step 5: Assign names to the steps and the jump exit/entry labels.

1. Double-click on the element you want to assign a name to. **Activates editing mode.**
2. Enter the name (Example: ‘Step_1’ through ‘Step_4’ and ‘Jump’).
Step 6: Assign transition conditions to the transitions

Note: You can use transition programs, TRUE/FALSE and Boolean variables (referenced by direct address or name) as transition conditions.

Assigning and creating a transition program

1. Double-click on the transition to which you wish to assign a program. Activates editing mode.
2. Enter the program name (Example: ‘TRAN_1’).
3. Click on the tool icon
   The New Transition dialog box is displayed, with the program name you just entered.
4. Select the programming language (Example: ladder diagram).
5. Click on OK. The body of the transition program is displayed automatically.
6. Write the transition program.
Assigning an existing variable to a transition

1. Double-click on the transition to which you wish to assign a variable. 
   Activates editing mode.

2. Enter the name of an existing variable 
   (Example: ‘Input2’ to ‘Input7’).

   **Note:** This overwrites the ‘TRUE’ transition condition.

---

**Step 7: Create the actions**

1. Select the ‘Process’ POU in the Project Navigator.

2. Click on the tool icon
   ![Tool Icon]

   Displays the New Action dialog box.

3. Enter a name for the action (Example: ‘Action_1’) and select the programming language (Example: ladder diagram).

   The new action is displayed in the
   Action Pool in the Project Navigator window.

4. Double-click on ‘Action_1’ to open the program editor.

5. Enter the program.

   **Note:** Transition and action programs are written in exactly the same way as any other POU. You can write these programs using instruction list, ladder diagram or function block diagram language. The sequential function chart language itself is not supported for these programs, however.
Step 8: Assign actions or Boolean variables to the steps

1. Select the step to which you wish to assign an action or variable (Example: 'Step_1').
2. Click on the tool icon.
   
   This displays the Action Association dialog box, which is still empty.

3. Press the m key.
   
   This displays the Action Name List box showing the actions and Boolean variables that are currently available.

4. Select the appropriate action/variable (Example: 
   'Initial' = 'Output1'
   'Step_1' = 'Action_1'
   'Step_1_a' = 'Output3'
   'Step_2' = 'Output4'
   'Step_3' = 'Output5'
   'Step_4' = 'Output6'

5. Close the Action Name List box by double-clicking on the control menu button.
   
   The step will now be displayed with a grey fill colour.
Checking PLC Programs (syntax check)

How to check your program for syntax errors

1. Select the object to be checked in the Project Navigator window.
2. Select Check in the Object menu

or

Click on the Syntax Check tool icon in the toolbar:

If the syntax check program finds any errors they are displayed and explained in the Compile/Check Messages box.

(3) You can display the source of any errors found automatically: Double-click on the corresponding error message in the Errors/Warnings list, or select the message and click on the Show button. This calls the object containing the error, with the source of the error highlighted in red.

Note: You can perform syntax checks both on individual objects and the entire project as a whole. You can also perform separate checks on the header and body of a single POU. Simply select the object to be checked in the Project Navigator (to check the entire project select the Project entry at the top of the tree).
Configuring Tasks

In this section it is assumed that you have already created the tasks for your project (see S2). Their entries are displayed in the Task Pool in the Project Navigator tree. Before you can use them in the program you must first specify the POUs you want to use in the tasks and configure the task attributes.

**How to assign PRG type POUs to tasks**

1. Double-click on the task’s entry in the Task Pool. A table is displayed on the right of the screen in which you can then assemble the task by specifying the POUs it is to contain.

   ![The task configuration table](image)

2. Click on the pop-up list icon in the first table line and select the POU you want to add to the task in the dialog box displayed. Confirm your selection with **OK**. Only POUs defined as programs (PRG) are included in the dialog box list. The name of the selected POU will then appear in the POU Name column in the first line of the table.

   **Note:** Only POUs that have not yet been included in a previously stored task are included in the dialog box list.

Using the | tab key, move the cursor to the next cell of the table and enter a comment for the POU entry in the Comment column (optional).

Repeat step 2 for each additional POU you wish to use in the task. To insert a new table line for the next POU entry, select **New Declaration** in the Edit menu, then select the position at which the line is to be inserted in the submenu.

When the cursor is on a comment cell that is currently in edit mode (white background) you can insert a new line at the end of the table automatically by pressing |.
How to configure the task execution attributes

1. Select the task to be configured in the Project Navigator window or in the task configuration table (select the grey number button in the first table column).

2. Press Alt to open the Task Information dialog box.

The parameters in this dialog box set the execution conditions and the security level for the current task. Tasks can be either event-triggered or interval-triggered. Full details on the various execution options can be found in the Reference Manual.

- Event = TRUE  
  (execute always)

- Interval = 0  
  (because event-triggered)

- Priority = 0  
  (maximum priority)

- Priority = 31  
  (lowest priority)

The dialog box also shows the current size of the task and the date and time of the last editing change.

**Note:** Please refer to the Reference Manual for details on configuration of the read/write access parameters.
Compiling Projects

When you compile a project the system translates the program code into executable form to prepare it for downloading to the controller CPU.

**How to compile a project**

1. Select **Compile Project** in the **Project** menu.

The progress of the compilation process and any errors found are documented in a status window.

**IMPORTANT:** Compilation does not download the program code to the CPU, this must be done separately!

Always perform a syntax check on the entire project before attempting to compile it (S7).
Before you can download a project to the PLC you must first configure the communications port you are going to use for this purpose.

**Note:** Before you begin, make sure that you know precisely which physical interface on your personal computer is going to be used for transferring the data to the PLC system.

### How to select and configure the communications port

1. Select **Transfer Setup** in the **Online** menu, then select **Ports** to display the **Transfer Setup** dialog box.

2. Click on the **Setup** button.

3. Select the desired serial port. **COM1** to **COM6** are available.

4. Confirm the entries in both dialog boxes with **OK**.
S11 ——— Downloading Programs (to PLC) ——————————— S11

When your program project is complete and has been checked for errors and successfully compiled you can download it to the controller system for execution.

**Connecting the PLC system**

1. Connect the PLC to your personal computer.
2. Make sure that you plug the connection cable into the same port on the computer that you defined in the settings described in S10 above.

**Note:** Please refer to the Reference Manual for details on the various different options available for connecting the PC and PLC systems.

**How to download a program to the PLC**

1. Select **Transfer Setup** in the **Online** menu, then select **Project**. The **Download Setup** dialog box is displayed on the screen.

   ![Download Setup Dialog Box]

   The **Download Setup** dialog box options are used to specify which data are downloaded to the PLC.

2. Click on **PLC Parameter and Program**, then confirm with **OK**.

   **IMPORTANT:** You must always download the PLC parameter when you transfer a program to the PLC for the first time!

3. Select **Transfer** in the **Project** menu, then select **MEDOC to PLC** to start the download. The transfer process is documented in a list box; if no error messages are displayed the transfer has been completed successfully.
S12 — Monitoring Programs

In monitoring mode, MM+ can display the current status and changes of the variables/devices used by your program.

**Note:** You can only monitor error-free programs that have been compiled and downloaded to the PLC system for execution.

1. Select **Monitoring Mode** in the **Online** menu. A check mark ✓ in front of the option in the menu indicates that the mode is currently active, and the entries in the Project Navigator window switch to light grey.
2. Open the body of the POU that you wish to monitor.
3. Select **Start Monitoring** in the **Online** menu.

**Important:** The PLC must be in RUN mode for monitoring to be possible.

The following examples illustrate how the status changes of the variables are displayed in monitoring mode for the various programming languages supported by MM+.

**Note:** More detailed information on the display options and other monitoring mode features can be found in the Reference Manual (Chapter 8).

---

**Function block diagram**

2#0: Binary#Off  
2#1: Binary#On

43: 43 seconds have elapsed

---

**Input1 = 2#1**  
**Timer2# = 2#1**  
100

**Timer2#**

**Set RST1**

**Input2 = 2#0**  
**Timer2# = 2#0**

**Output1 = 2#0**  
**Data = 43**
Ladder diagram

Filled field between the input contacts:
On
2#0: Binary#Off
2#1: Binary#On
87: 87 seconds have elapsed

Instruction list

On/Off status is indicated by different colours.

LD
TIMER_M
CAL
LD
MOVE
ST
LD
TIMER3
J0
LD
MOVE
ST
Data 38
S13 ———— Uploading Data from the CPU ————————————— S13

How to upload data from the PLC’s CPU to MM+

1. Select Transfer in the Project menu, then select the PLC to MEDOC (MELSEC) option.

2. This displays the PLC Parameter dialog box. Select the appropriate CPU Type and confirm with OK (see S1).

3. In the next dialog box MM+ asks you to specify the path and name for the uploaded project data, which will be stored as a new project. If you want to create a new project for the upload follow the instructions in S1. If a project is already open you can abort the procedure by clicking on the Cancel button.

4. Click on Setup in the Transfer Setup dialog box.

5. This displays the Transfer Setup (CPU port) dialog box. Select the correct port for your system configuration (see S10).

6. Confirm your entries in both dialog boxes with OK.

This starts the upload procedure. Progress and any errors are documented in a list box.
Sample Program: CarPark

The arrowed references to the left of some of the headings below indicate where the instructions for the necessary procedures can be found in the 'Getting Started' chapter.

Note: This sample program is only intended as an illustration of programming and program structure techniques in MM+. In its present version it cannot be used as a basis for producing your own executable programs. The sample version has been written for a MELSEC FX series controller.

Description

The roll-up door of a car park building can be opened from inside and outside with a key-operated switch. Safety functions included in the program ensure that the door opens automatically in the event of an alarm, and that it does not remain open for too long when no cars are entering or leaving the car park. The program also keeps track of the number of cars in the building.

Project Structure
The Task ‘Main’

... always runs in the background, with maximum priority. This task contains the POUs ‘Control’ and ‘Counter’, which perform the following functions:

POU ‘Control’
– Car park status check
– Close car park door if no car drives in or out within a 60-second period
– Open car park door when an alarm is triggered

POU ‘Counter’
– Count the cars

The Task ‘Door_Operate’

... is event-triggered. It is activated when the OK signal for the car park door (variable: CPark_OK) is set. This task contains the POU ‘Door_Control’, which handles the following functions:

POU ‘Door_Control’
– Open car park door when the key switches inside and outside the car park are operated.
– Close the car park door after the car passes through the photoelectric barrier.

Note: MM+ allows you to apply an engineering design approach to project planning and programming. This is illustrated in the ‘CarPark’ project. Steps S1 through S11 are fully documented.

In the sample program all the variables are already known and declared at the outset. Of course, this ideal situation is not always possible in actual projects; one often has to make corrections and add and delete variables in the course of the programming work. This flexible approach is fully supported in MM+; the system allows you to edit, add and delete variable declarations at any time, both during programming and afterwards.
Create the new ‘CarPark’ project

The first step is to create a new project. Refer to the instructions in S1 and enter ‘CarPark’ as the project name in step 4.

Create the tasks

Create the ‘Main’ and ‘Door_Operate’ tasks.

Declare the global variables

Declare the global variables shown in the table below. The entries in the Comment column are optional.

<table>
<thead>
<tr>
<th>Class</th>
<th>Autoext</th>
<th>Identifier</th>
<th>M#-Addt.</th>
<th>IEC-Addt.</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_GLOBAL</td>
<td>Door_Open</td>
<td>XI</td>
<td>Y0:00</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Upper door limit switch</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Door_Closed</td>
<td>XI</td>
<td>Y0:01</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lower door limit switch</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Motor_Up</td>
<td>Y0</td>
<td>Y0:02</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor lifts car park door up</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Motor_Down</td>
<td>Y1</td>
<td>Y0:03</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor lifts car park door down</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Enter_Up</td>
<td>X2</td>
<td>X0:04</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Key switch door open for entry</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Exit_Up</td>
<td>X3</td>
<td>X0:05</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Key switch door open for exit</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Exit_Car_Gone</td>
<td>X5</td>
<td>X0:06</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Photocell barrier for car entrance</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Enter_Car_Gone</td>
<td>X4</td>
<td>X0:07</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Photocell barrier for car exit</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Max_Time_Up_C</td>
<td>T0</td>
<td>Y0:08</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer coil: When the time has elapsed</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Max_Time_Up_S</td>
<td>T50</td>
<td>Y0:09</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer contact: When the time has elapsed</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Main_Switch</td>
<td>X6</td>
<td>X0:10</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Main switch: Car park door is in operation</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Help_Altarm</td>
<td>X7</td>
<td>X0:11</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Alarm switch</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>CO2_Altarm</td>
<td>X10</td>
<td>X0:12</td>
<td>BOOL</td>
<td>FALSE</td>
<td>CO2 sensor</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>CPark_OK</td>
<td>M0</td>
<td>X0:13</td>
<td>BOOL</td>
<td>FALSE</td>
<td>OK signal: Car park door can be used</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>CPark_OK_Lamp</td>
<td>Y3</td>
<td>X0:14</td>
<td>BOOL</td>
<td>FALSE</td>
<td>OK signal: Car park door can be used</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Time_Central</td>
<td>M1</td>
<td>X0:15</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Internal relay for the close process</td>
<td></td>
</tr>
<tr>
<td>VAR_GLOBAL</td>
<td>Cars_Number</td>
<td>D0</td>
<td>X0:16</td>
<td>INT</td>
<td>0</td>
<td>Number of cars in the car park</td>
<td></td>
</tr>
</tbody>
</table>
Create the program organisation units

Create the three program organisation units: ‘Control’, ‘Counter’ and ‘Door_Control’. Define all three POUs as programs (PRG) and specify ladder diagram (LD) as the programming language.

Each POU consists of a header and a body. The header contains the declarations of the variables used by the POU, the body contains the actual PLC program code.

Project Navigator Window

All the tasks and POUs you create are automatically displayed in the Project Navigator window.

---

Tasks:
- ‘Door_Operate’
- ‘Main’

POUs:
- ‘Control’
- ‘Counter’
- ‘Door_Control’
Program the headers

All the variables used in the 'CarPark' sample program are declared as global variables. The next step is to declare the variables used in each POU in the POU headers. The quickest way to do this is to copy the variables in the global variable list and then paste them into the declaration tables of the headers of the individual POUs.

Note: The keyboard commands for selecting single and multiple lines in tables are listed in the appendix of the Reference Manual ("Table Keys").

Header of the 'Control' POU

<table>
<thead>
<tr>
<th>Class</th>
<th>Identifier</th>
<th>Type</th>
<th>Initial</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Door_Open</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Upper door limit switch</td>
</tr>
<tr>
<td>1</td>
<td>Door_Closed</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lower door limit switch</td>
</tr>
<tr>
<td>2</td>
<td>Time_Control</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Internal relay for the close process</td>
</tr>
<tr>
<td>3</td>
<td>Motor_Up</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor rolls car park door up</td>
</tr>
<tr>
<td>4</td>
<td>Motor_Down</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor rolls car park door down</td>
</tr>
<tr>
<td>5</td>
<td>Enter_Up</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Key switch door open for entry</td>
</tr>
<tr>
<td>6</td>
<td>Exit_Up</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Key switch door open for exit</td>
</tr>
<tr>
<td>7</td>
<td>Enter_Car_One</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Photoelectric barrier for car entrance</td>
</tr>
<tr>
<td>8</td>
<td>Exit_Car_One</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Photoelectric barrier for car exit</td>
</tr>
<tr>
<td>- 9</td>
<td>Max_Time_Up_G</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer coil. When the time has elapsed the car park door is closed</td>
</tr>
<tr>
<td>- 10</td>
<td>Max_Time_Up_G</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer coil. When the time has elapsed the car park door is closed</td>
</tr>
<tr>
<td>11</td>
<td>Main Switch</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Main switch: Car park door is in operation</td>
</tr>
<tr>
<td>12</td>
<td>Help_Alarm</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Alarm switch</td>
</tr>
<tr>
<td>13</td>
<td>CO2_Alarm</td>
<td>BOOL</td>
<td>FALSE</td>
<td>CO2 sensor</td>
</tr>
<tr>
<td>14</td>
<td>CPark_OK</td>
<td>BOOL</td>
<td>FALSE</td>
<td>OK signal. Car park door can be used</td>
</tr>
<tr>
<td>15</td>
<td>CPark_OK_Lamp</td>
<td>BOOL</td>
<td>FALSE</td>
<td>OK signal. Car park door can be used</td>
</tr>
</tbody>
</table>
**Header of the 'Counter' POU**

<table>
<thead>
<tr>
<th>Schlüsselwort</th>
<th>Bezeichner</th>
<th>Typ</th>
<th>Vorgeben</th>
<th>Kommentar</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_EXTN</td>
<td>Rein_Auto_Weg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lichthindern beim Hinfahren</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Rein_Auto_Weg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lichthindern beim Hinaustehen</td>
</tr>
<tr>
<td></td>
<td>Anzahl_Autos</td>
<td>INT</td>
<td>0</td>
<td>Anzahl der Autos, die sich in der Garage befinden</td>
</tr>
</tbody>
</table>

**Header of the 'Door_Control' POU**

<table>
<thead>
<tr>
<th>Schlüsselwort</th>
<th>Bezeichner</th>
<th>Typ</th>
<th>Vorgeben</th>
<th>Kommentar</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_EXTN</td>
<td>Tor_Auf</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Endschalter Tor oben</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Tor_Zu</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Endschalter Tor unten</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Motor_Hoch</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor läuft das Gezagsmotor auf</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Motor_Runger</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Motor läuft das Gezagsmotor runter</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Rein_Auf</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Schlussabdeckung beim Hinfahren</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Rein_Auf</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Schlussabdeckung beim Hinaustehen</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Auto_Weg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lichthindern beim Hinfahren</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Auto_Weg</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Lichthindern beim Hinaustehen</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Max_Zeit_Auf_C</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer: Spalte Nach Ablauf der Zeit wird das Gezagmotor geschlossen</td>
</tr>
<tr>
<td>VAR_EXTN</td>
<td>Max_Zeit_Auf_S</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Timer: Kontakt Nach Ablauf der Zeit wird das Gezagmotor geschlossen</td>
</tr>
</tbody>
</table>
Program the bodies

Body of the ‘Control’ POU

- Door control activation
- Help call and CO2-alarm
- Timer activation
- Time control
- Close car park door
- Reset
Door control activation
When the main switch is on and no help call or CO2 alarm is registered the OK signal (variable: ‘CPark_OK’) for the 'Door_Control' program organisation unit is set and the CPark_OK_Lamp is switched on.

Help call and CO2 alarm
As soon as an alarm is registered the motor rolls the car park door up. The motor is reset when the door activates the upper limit switch (‘Door_Open’).

Timer activation
When the door is open and the photoelectric barriers at the entrance (‘Enter_Car_Gone’) and the exit (‘Exit_Car_Gone’) do not register any vehicles the timer ‘Max_Time_Up_C’ starts to count for 60 seconds.

Time control
The ‘Time_Control’ relay is set as soon as the 60-second period has elapsed.

Close car park door
When no traffic is registered or the main switch is turned off and no alarm is registered the motor rolls the car park door down into the closed position.

Reset
When no traffic is registered or the main switch is turned off and the door reaches the lower limit switch (‘Door_Closed’) both the motor and the ‘Time_Control’ relay are reset.
Body of the ‘Counter’ POU

**Entrance**

The program counts the cars driving into the car park by incrementing the total number stored in the ‘Cars_Number’ data register every time a car enters.

**Exit**

Every time a car drives out of the building the program decrements the number stored in the data register. The result is that the number always corresponds to the exact number of cars in the building.
Body of the ‘Door_Control’ POU

Conditions for activation of the door control routine

The Door_Control POU can only be executed when the ‘CPark_OK’ variable in the Control POU is set. ‘CPark_OK’ is only set if

- The main switch is on, and
- No help call alarm is registered, and
- No CO2 alarm is registered.

### Sample Program: CarPark

<table>
<thead>
<tr>
<th>Torsteuerung [PHG] Body [KOP]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open car park door</td>
</tr>
</tbody>
</table>

- Raut_Auf
- Tor_Auf
- Motor_Hoch

<table>
<thead>
<tr>
<th>- Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Raut_Schl</td>
</tr>
</tbody>
</table>

| Close car park door |

- Tor_Auf
- Raut_Auto Weg
- Motor_Rue

<table>
<thead>
<tr>
<th>- Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Raut_Schl</td>
</tr>
</tbody>
</table>

<p>| |</p>
<table>
<thead>
<tr>
<th>- -</th>
</tr>
</thead>
<tbody>
<tr>
<td>- -</td>
</tr>
</tbody>
</table>

MELSEC MEDOC plus

Beginner's Manual
Open car park door

When the car park door is closed the key switch inside ('Exit_Up') or outside ('Enter_Up') the building must be operated to open the door.

Reset

The motor is reset when the car park door reaches the upper limit switch ('Door_Open').

Close car park door

When a car passes through the photoelectric barrier after driving in ('Enter_Car_Gone') or out ('Exit_Car_Gone') of the building the motor starts to close the car park door.

Reset

When the door reaches the lower limit switch ('Door_Closed') the motor is reset.
Configure the tasks

We have already created the two tasks needed by the program, ‘Main’ and ‘Door_Operate’ (see S2).

The next step is to assign the POUs to the tasks, which are still ‘empty’. Double-click on the task name in the Project Navigator, then select the pop-up arrow icon in the cell in the POU Name column, and select the POU from the list displayed.

After assigning the POUs you must then configure the task attributes. Select the task in the Project Navigator window or open the task configuration table by double-clicking on its name, then press or select Information in the Object menu to open the Task Information dialog box.

The ‘Main’ task

Assign the POUs ‘Control’ and ‘Counter’ to the ‘Main’ task.

Attributes of the ‘Main’ task

Event: TRUE

... i.e. the task’s two POUs ‘Control’ and ‘Counter’ both run continuously.

Priority: 1
The 'Door_Operate' Task

The 'Door_Operate' task contains the POU 'Door_Control'.

Attributes of the 'Door_Operate' task

Event: 'CPark_OK'
...i.e. the associated POU Door_Control is only activated when the 'CPark_OK' signal is set.
Priority: 31

Note: Entry of the project data is now complete.

Compile the project (S9), configure the ports of your personal computer (S10) and download the program to the controller CPU (S11). Monitoring mode for following the status of the program variables is explained in S12.
Sample Program: CarPark
Importing

There are two different ways to import projects created with the older MELSEC MEDOC programming package for use in MM+:

- Import by loading a MELSEC MEDOC print file
- Import by uploading directly from the CPU

**Loading a print file to MM+**

**Procedures in MELSEC MEDOC**

1. Select a file name as the printer port. The extension `TMP` is added automatically by the program.
2. Make sure that only Instruction List and Name List are selected in the program listing options. The Header must be switched off!
3. Start the print procedure.

**Procedures in MM+**

4. Open the body of an existing MELSEC instruction list program or create a new POU and specify MELSEC instruction list as the language. **Important:** Make very sure that the POU is declared as a program (PRG).
5. Open the POU body, then select **Import MEDOC Network** in the **Tools** menu.
6. This opens a file selection box. Select the drive and directory, and then select the print file (`TMP`) that you want to load and confirm your choice with **OK**. This opens another dialog box.
7. Confirm the settings with **OK**  
   (MEDOC Program = Instruction list only,  
   MEDOC Symbolic Names = Name list only).

The progress of the import procedure is documented in a status window.
8 – 2 Importing
### Index – i

| A | Absolute address,  3-7  
Action,  3-18, 6-32  
Actual parameter,  3-4 |
| --- | --- |
| B | Bit accumulator,  3-12  
Body,  3-2, 6-9 |
| C | Checking,  6-34  
Class,  3-7, 3-8  
Colors,  6-3  
Comment,  3-7, 3-9  
Communications port,  6-38  
Compiling,  6-37 |
| D | Data type,  3-7, 3-9  
Declaration table,  5-3  
Derived data type,  3-9  
Downloading,  6-39  
DUT Pool,  3-1 |
| E | Editor,  5-5  
Elementary data type,  3-9  
Extended information,  6-3 |
| F | Final step,  6-24  
Formal parameter,  3-4  
Function,  2-2, 3-2, 3-3, 3-14, 3-16, 3-17  
Function block,  2-2, 3-2, 3-3, 3-13, 3-16, 3-17  
Function Block Diagram,  2-4, 3-10, 3-17, 5-5, 6-12 |
| G | Global variable,  2-5, 3-1, 3-7, 6-5  
Graphical editor,  2-4, 3-15, 5-5 |
| H | Header,  3-2, 6-8  
Help,  1-2 |
| I | Identifier,  3-7, 3-8  
IEC address,  3-8  
IEC Instruction List,  3-10, 5-5  
Importing,  8-1, 8-2  
Initial step,  3-19, 6-24  
Initial value,  3-7, 3-9  
Installing,  4-1  
Instance,  3-4  
Instancing,  3-4  
Instruction List,  2-4, 3-10 |
| J | Jump entry point,  3-19, 6-29  
Jump exit point,  3-19, 6-30 |
| L | Ladder Diagram,  2-4, 3-10, 3-15, 5-5, 6-10  
Local variable,  2-5, 3-7 |
| M | Macro step,  3-20  
Manufacturer library,  3-1  
MELSEC Instruction List,  3-10, 5-5  
Menu bar,  5-2  
MITSUBISHI address,  3-8  
Monitoring,  6-40 |
| N | Navigator,  5-2  
Negated contact/coil/variable,  6-15 |
| P | Parameter,  3-4  
PLC configuration,  3-1  
POU Pool,  3-1  
Program,  2-2, 3-2, 3-3  
Program Organisation Unit,  2-2, 3-2, 6-7  
Programming language,  3-10  
Project,  3-1, 6-2 |
| S | Sequential Function Chart,  2-4, 3-10, 3-18, 5-5, 6-22  
Signal configuration,  6-15  
Standard library,  3-1  
Status bar,  5-2  
Step,  3-18  
Structured programming,  2-2  
Syntax check,  6-34 |
| T | Task,  2-3, 3-6, 6-4, 6-35  
Task Pool,  3-1  
Text editor,  2-4, 3-10, 5-5  
Timer,  6-16  
Toolbar,  5-2  
Transition,  3-18  
Transition condition,  3-18, 6-31 |
| U | Uploading,  6-42  
User interface,  5-1 |
| V | Variable,  2-5, 3-7 |
| W | Windows,  5-2  
Wizard,  6-3 |

---

Beginner's Manual

MELSEC MEDOC plus
MELSEC MEDOC plus
IEC Programming and Documentation System

Beginner's Manual

Specifications subject to change without notice. Art. No.: 43596-D